Kepler - Issues

# Tracker Status Priority Subject Assignee Updated

5694 Bug Resolved Immediate Dragging from a port results in a NPE Daniel Crawl 09/07/2012 11:16 AM
5621 Bug Resolved Immediate Need change the access order type from denyFirst to allowFirst in kepler when it generate Jing Tao 08/23/2012 11:39 AM

emls
5405 Bug Resolved Immediate remove tagging's BasicGraphController override Sean Riddle 06/14/2011 06:49 PM
5350 Bug Resolved Immediate Kepler doesn't close completely Aaron Aaron 03/22/2011 03:51 PM
5263 Bug Resolved Immediate failure to restart after upgrade from 2.0 to 2.1 David Welker 01/19/2011 01:08 PM
5146 Bug Resolved Immediate modifying and saving the composite sinewave actor fails Derik Barseghian 01/05/2011 04:39 PM
5144 Bug Resolved Immediate renaming an actor does not persist in saved kar files Aaron Aaron 12/10/2010 11:57 AM
5142 Bug Resolved Immediate comma improperly inserted in kar filename rather than a period (.) Daniel Crawl 07/10/2012 02:07 PM
5085 Bug Resolved Immediate add table of contents to User's Guide jianwu jianwu 07/21/2010 04:51 PM
4943 Bug Resolved Immediate RC5 Installer Tracking Bug David Welker 07/07/2010 04:18 PM
4941 Bug Resolved Immediate Data search causes menus to disappear on the mac Chad Berkley 04/20/2010 04:25 PM
4940 Bug Resolved Immediate User is never notified of incorrect login Chad Berkley 04/16/2010 03:47 PM
4899 Bug Resolved Immediate Installer Bugs Chad Berkley 04/15/2010 11:27 AM
4873 Bug Resolved Immediate Actors in repository library subtree are crammed together Aaron Aaron 03/11/2010 01:21 PM
4723 Bug Resolved Immediate workflows directory should be moved Aaron Aaron 02/10/2010 02:50 PM
4722 Bug Resolved Immediate find 1.0 -> 2.0 .kepler incompatibilities Chad Berkley 02/04/2010 01:05 PM
4704 Bug Resolved Immediate Generate XML for a KARFile Aaron Aaron 02/08/2010 05:57 PM
4702 Bug Resolved Immediate KAR to module conversion utility David Welker 02/12/2010 11:59 PM
4701 Bug Resolved Immediate Persistent Database needed in Core Module for LSID generation to prevent namespace Daniel Crawl 01/29/2010 03:34 PM
updating on clean-cache

4686 Bug Resolved Immediate update copyright statements Chad Berkley 02/05/2010 12:20 PM
4684 Bug Resolved Immediate Release tracking bug Chad Berkley 03/10/2010 01:53 PM
4670 Bug Resolved Immediate svn update fails to update module with modifications Chad Berkley 01/15/2010 10:29 AM
4666 Bug Resolved Immediate identify problems with converting .kepler-1.0 to .kepler-2.0 Chad Berkley 02/04/2010 01:07 PM
4665 Bug Resolved Immediate Add unit tests for kar functionality Chad Berkley 02/05/2010 12:49 PM
4664 Bug Resolved Immediate Fix and/or remove broken unit tests Chad Berkley 01/19/2010 03:14 PM
4655 Bug Resolved Immediate data packages are suddenly unusable Daniel Crawl 01/08/2010 01:37 PM
4648 Bug Resolved Immediate Create classes to find and display any available documentation for installed modules or suites. | debi staggs 04/13/2010 04:12 PM
4633 Bug Resolved Immediate LSID conflicts Aaron Aaron 01/27/2010 04:54 PM
4632 Bug Resolved Immediate problems when loading a KAR, changing the workflow, then re-saving the KAR ben leinfelder 12/18/2009 12:09 PM
4608 Bug Resolved Immediate ROML in KAR files not being shown at all Derik Barseghian 12/08/2009 03:21 PM
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4597 Bug Resolved Immediate adding new configuration properties before/after a certain exiting configuration property. Chad Berkley 12/08/2009 12:32 PM
4579 Bug Resolved Immediate Remove all references to specific module names from the code. Chad Berkley 12/02/2009 04:39 PM
4578 Bug Resolved Immediate tracking bug for changes to .kepler Derik Barseghian 02/23/2010 09:46 AM
4559 Bug Resolved Immediate local repositories not showing up in components tree Aaron Aaron 01/28/2010 10:38 AM
4527 Bug Resolved Immediate reports cannot be loaded when InstanceAuthNamespace changes ben leinfelder 11/06/2009 09:05 AM
4521 Bug Resolved Immediate KNB data error checking is overly aggressive Jing Tao 11/04/2009 09:55 AM
4520 Bug Resolved Immediate Login Anonymously Fails Chad Berkley 11/17/2009 12:28 PM
4517 Bug Resolved Immediate Verify that the search capabilities work Jing Tao 04/26/2010 01:47 PM
4515 Bug Resolved Immediate Finish and Document the Save/Open KAR file functionality Aaron Aaron 01/28/2010 12:42 PM
4514 Bug Resolved Immediate Files are being saved in the Kepler installation directory Aaron Aaron 12/17/2009 06:47 PM
4507 Bug Resolved Immediate report designer losing content when there are too many items debi staggs 11/20/2009 12:04 PM
4483 Bug Resolved Immediate Module dependencies in MoML files David Welker 05/02/2011 04:52 PM
4462 Bug Resolved Immediate Component search in remote repositories not working Sean Riddle 04/16/2010 11:34 AM
4457 Bug Resolved Immediate Workflow Run Manager - past Report Layouts don't open ben leinfelder 11/18/2009 11:48 AM
4421 Bug Resolved Immediate Component Search fails Aaron Aaron 09/29/2009 01:30 PM
4394 Bug Resolved Immediate Need to develop requirements for configuration subsystem Chad Berkley 10/05/2009 11:54 AM
4343 Bug Resolved Immediate remove the full screen button Chad Berkley 09/18/2009 11:34 AM
4340 Bug Resolved Immediate Resolve KAR file/module format Aaron Aaron 01/13/2010 02:10 PM
4338 Bug Resolved Immediate need to review usability and gui of module manager Chad Berkley 01/19/2010 09:58 AM
4337 Bug Resolved Immediate 1.0 -> 2.0 upgrade issues tracking bug Chad Berkley 02/25/2010 05:28 PM
4336 Bug Resolved Immediate Merge the old configuration systems Chad Berkley 12/07/2009 11:43 AM
4333 Bug Resolved Immediate KeplerLSID AuthNamespace web service Aaron Aaron 03/12/2010 02:01 PM
4330 Bug Resolved Immediate common/resources/configurations/config.xml gets modified during build or run Chad Berkley 09/18/2009 03:37 PM
4322 Bug Resolved Immediate Attempting to save changes to a workflow saved in a KAR file fails Aaron Aaron 02/02/2010 04:42 PM
4320 Bug Resolved Immediate Component Library Folders and Popup Menus Aaron Aaron 11/24/2009 09:58 AM
4319 Bug Resolved Immediate LibraryManager Aaron Aaron 11/24/2009 09:40 AM
4312 Bug Resolved Immediate Clicking cancel on "sure you want to exit" dialog exits anyway Chad Berkley 09/16/2009 03:40 PM
4305 Bug Resolved Immediate Move actor classes into the actors module Chad Berkley 08/18/2009 10:13 AM
4304 Bug Resolved Immediate Progress monitor is blank when authenticating for KAR upload Sean Riddle 01/27/2010 11:28 AM
4286 Bug Resolved Immediate Changes to the GUI before 2.0 David Welker 01/07/2010 07:12 PM
4282 Bug Resolved Immediate Duplicate of ptolemy.gui.Top Chad Berkley 09/11/2009 10:42 AM
4278 Bug Resolved Immediate Changes to a reopened KAR are not saved to the new KAR Aaron Aaron 09/03/2009 04:17 PM
4250 Bug Resolved Immediate Add other suites to the nightly build Chad Berkley 08/12/2009 02:54 PM
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4249 Bug Resolved Immediate create 64 bit installers Chad Berkley 07/16/2009 11:40 AM
4238 Bug Resolved Immediate Report Designer - Improve the listeners for the static items. debi staggs 07/26/2009 03:12 PM
4236 Bug Resolved Immediate Report Designer - Can't add two static image items and then change their images. debi staggs 07/26/2009 03:58 AM
4214 Bug Resolved Immediate Report Designer - Dragging workflow components near report fields adds text to the fields debi staggs 07/01/2009 05:29 PM
4212 Bug Resolved Immediate Report Designer - Clicking the delete button removes unselected items debi staggs 07/01/2009 05:26 PM
4210 Bug Resolved Immediate Report Designer - scrollbar goes off the screen debi staggs 06/30/2009 04:40 PM
4209 Bug Resolved Immediate Report Designer - Text randomly disappears when dragging new components debi staggs 06/30/2009 04:40 PM
4208 Bug Resolved Immediate Report Designer - dragging from the component window to the canvas does not drop where debi staggs 06/30/2009 02:06 PM

you want it

4207 Bug Resolved Immediate Report Designer - drop area is too small debi staggs 07/01/2009 05:28 PM
4206 Bug Resolved Immediate Report Designer - layout in left pane is scrunched up debi staggs 06/30/2009 04:04 PM
4205 Bug Resolved Immediate Report Designer - dragging component makes text disappear debi staggs 06/30/2009 10:58 AM
4204 Bug Resolved Immediate Report Designer - finding drag area on components is hard debi staggs 07/07/2009 03:12 PM
4199 Bug Resolved Immediate NPE in org.kepler.moml.NamedObjld Chad Berkley 07/16/2009 02:05 PM
4198 Bug Resolved Immediate important sanparks tasks Chad Berkley 07/10/2009 11:33 AM
4179 Bug Resolved Immediate ant jar does not include configs/ Chad Berkley 01/14/2010 11:34 AM
4174 Bug Resolved Immediate Actor library not building correctly Aaron Aaron 06/23/2009 02:30 PM
4163 Bug Resolved Immediate erroneous hsql database creation Daniel Crawl 06/25/2009 04:02 PM
4161 Bug Resolved Immediate Develop kepler workflow execution engine Jing Tao 04/19/2010 01:16 PM
4159 Bug Resolved Immediate Cut 2.0-alpha/SanParks release Chad Berkley 07/10/2009 02:17 PM
4152 Bug Resolved Immediate Modules should be able to add environment variables to the runtime Chad Berkley 06/12/2009 01:59 PM
4150 Bug Resolved Immediate Save in Library broken Aaron Aaron 12/02/2009 01:00 PM
4120 Bug Resolved Immediate Bug in OpenDBConnector actor Chad Berkley 06/01/2009 11:24 AM
4111 Bug Resolved Immediate move test data to a more appropriate locations Chad Berkley 06/02/2009 03:21 PM
4105 Bug Resolved Immediate Make build system automatically build OS dependent modules Chad Berkley 06/02/2009 03:08 PM
4093 Bug Resolved Immediate allow kepler to use OS specific Ul elements Chad Berkley 05/26/2009 03:49 PM
4088 Bug Resolved Immediate Create new configuration system David Welker 07/13/2009 04:08 PM
4065 Bug Resolved Immediate Copy documentation into installer Chad Berkley 06/10/2009 12:53 PM
4064 Bug Resolved Immediate remove r installer after installation is complete Chad Berkley 06/02/2009 03:47 PM
4034 Bug Resolved Immediate "Invalid memory access" when running workflow from the command line David Welker 06/12/2009 02:14 PM
4026 Bug Resolved Immediate Bootstrapper will not run kepler in a directory with spaces Chad Berkley 04/28/2009 11:58 AM
4019 Bug Resolved Immediate Workflow View in left pane Aaron Aaron 08/10/2009 04:23 PM
4018 Bug Resolved Immediate Remove non-2.0 functionality from 2.0 release Chad Berkley 07/10/2009 02:34 PM
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4017 Bug Resolved Immediate Make sure module manager and installer work together wrt the classpath Chad Berkley 05/04/2009 03:23 PM
4014 Bug Resolved Immediate Remove "include class" checkbox in export kar dialog ben leinfelder 04/24/2009 12:32 PM
4013 Bug Resolved Immediate Make sure duplicate jars are not included in the installer Chad Berkley 07/10/2009 02:26 PM
4009 Bug Resolved Immediate kepler 2.0 must provide everything needed for modules David Welker 02/05/2010 12:51 PM
3997 Bug Resolved Immediate Supporting display actor conversion for command line execution. jlanwu jianwu 07/31/2012 10:55 AM
3977 Bug Resolved Immediate Devlop test for ptll overrides in the system Chad Berkley 04/22/2009 03:35 PM
3976 Bug Resolved Immediate Update Documentation for 2.0 release debi staggs 05/06/2010 04:31 PM
3967 Bug Resolved Immediate Unable to run java -jar kepler-trunk.jar with -nogui -nocache -runwf fullworkflowpath options Chad Berkley 04/24/2009 04:46 PM
3949 Bug Resolved Immediate Get the installer working with the new build system Chad Berkley 07/13/2009 02:01 PM
3948 Bug Resolved Immediate Create new configuration system supporting modules Chad Berkley 10/29/2009 01:12 PM
3947 Bug Resolved Immediate Create a module manager David Welker 08/26/2009 01:24 PM
3939 Bug Resolved Immediate Kepler Unique LSID Namespace generation Aaron Aaron 05/19/2009 09:22 PM
3898 Bug Resolved Immediate update .kepler instead of removing it between versions Aaron Aaron 02/04/2010 12:59 PM
3734 Bug Resolved Immediate Some demos no longer work after new build/repos Chad Berkley 06/03/2009 03:37 PM
3691 Bug Resolved Immediate JButton labels truncated on macOSX Derik Barseghian 05/19/2009 05:57 PM
3672 Bug Resolved Immediate Open/Save Workflow as KAR Archive Aaron Aaron 09/08/2009 04:03 PM
3607 Bug Resolved Immediate Create model for the Report Object debi staggs 05/19/2009 11:09 AM
3483 Bug Resolved Immediate case sensitive Leopard install fails Chad Berkley 04/24/2009 04:44 PM
3369 Bug Resolved Immediate Kepler will not start (OS X 10.52) as JavaApplicationStub is not executable Chad Berkley 04/24/2009 04:42 PM
3271 Bug Resolved Immediate Random Errors with data authentication system Chad Berkley 05/09/2008 11:16 AM
3269 Bug Resolved Immediate authentication system throws NPE Chad Berkley 05/09/2008 11:17 AM
3248 Bug Resolved Immediate .sh files should be removed for windows installer Chad Berkley 05/08/2008 10:26 AM
3247 Bug Resolved Immediate Documentation intro screen typo Chad Berkley 05/07/2008 02:41 PM
3246 Bug Resolved Immediate Typo in Documentation Screen Chad Berkley 05/07/2008 02:38 PM
3245 Bug Resolved Immediate Release 1.0 installer tracking bug Chad Berkley 07/31/2008 12:29 AM
3211 Bug Resolved Immediate Need XSLT stylesheet to build actor docs Chad Berkley 04/09/2008 10:14 AM
3200 Bug Resolved Immediate create a 1.0.0 branch in cvs Chad Berkley 04/03/2008 01:46 PM
3199 Bug Resolved Immediate include R 2.6 in the installer Chad Berkley 04/07/2008 12:03 PM
3196 Bug Resolved Immediate Find/Change license on gpl/Igpl code Timothy McPhillips 05/01/2008 09:23 AM
3195 Bug Resolved Immediate Check all documentation for 1.0 release Chad Berkley 04/28/2008 02:10 PM
3182 Bug Resolved Immediate check for consistent licensing text in all source files Timothy McPhillips 04/23/2008 10:02 AM
3167 Bug Resolved Immediate Customize documentation fails when ports added Chad Berkley 04/03/2008 01:12 PM
3144 Bug Resolved Immediate add link in OSX Applications folder Chad Berkley 04/15/2008 01:09 PM
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3138 Bug Resolved Immediate remove the distributed options menu item for 1.0 release Chad Berkley 04/03/2008 01:08 PM
3133 Bug Resolved Immediate R is not added to the path Dan Higgins 02/05/2008 01:51 PM
3131 Bug Resolved Immediate R is not added to the path Chad Berkley 02/14/2008 10:46 AM
3129 Bug Resolved Immediate links exist to ptll demos that do not work Chad Berkley 02/05/2008 07:51 PM
3126 Bug Resolved Immediate add R system installation to the Mac installer Chad Berkley 04/09/2008 11:51 AM
3123 Bug Resolved Immediate Change icons to be kepler specific Chad Berkley 02/07/2008 04:23 PM
3122 Bug Resolved Immediate Get installer size down Chad Berkley 05/12/2008 12:31 PM
3109 Bug Resolved Immediate Many demos linked to getting started don't work Chad Berkley 01/29/2008 11:34 AM
3070 Bug Resolved Immediate Need access control GUI for slaves jianwu jianwu 03/17/2010 03:31 PM
3069 Bug Resolved Immediate start slave from gui jianwu jianwu 03/16/2010 01:54 PM
3068 Bug Resolved Immediate rmiregistry should be started programmatically jianwu jianwu 03/16/2010 01:52 PM
3054 Bug Resolved Immediate Importing a kar file claims actor is already cached Chad Berkley 01/15/2008 12:48 PM
3030 Bug Resolved Immediate Documentation says that kepler is version 1.0.0alpha8 Matt Jones 02/01/2008 02:14 AM
3029 Bug Resolved Immediate NPE when trying to save semantic type Shawn Bowers 12/17/2007 02:28 PM
3027 Bug Resolved Immediate jar handling issues Chad Berkley 02/25/2010 03:11 AM
2941 Bug Resolved Immediate Command Line Exec Actor throws exception when given input on "arguments" port Daniel Crawl 01/16/2008 01:25 PM
2933 Bug Resolved Immediate Query Builder comparisons for strings, dates do not work Jing Tao 01/23/2008 11:12 AM
2830 Bug Resolved Immediate Actor names to change/actors to remove from application Chad Berkley 12/18/2007 11:13 AM
2755 Bug Resolved Immediate generateDocs replaces & with &amp; erroneously llkay Altintas 05/18/2007 11:51 AM
2746 Bug Resolved Immediate Documentation system does not work with java 1.6 llkay Altintas 05/18/2007 11:50 AM
2531 Bug Resolved Immediate The link from Kepler intro page to the Ptolemy quick links page is broken Christopher Brooks 04/15/2008 06:59 PM
2493 Bug Resolved Immediate actor repository tracking bug Sean Riddle 04/16/2010 11:35 AM
2433 Bug Resolved Immediate Change Actor Library folder icons to ontology symbols Matthew Brooke 05/19/2006 10:52 AM
2412 Bug Resolved Immediate Unable to Create Kar file from composite Chad Berkley 04/12/2007 02:05 PM
2374 Bug Resolved Immediate SVG - Improve inital rendering times Matthew Brooke 04/03/2009 01:11 PM
2363 Bug Resolved Immediate Move Actions out of BasicGraphController Christopher Brooks 04/30/2009 09:58 AM
2361 Bug Resolved Immediate Using backspace in the search pane deletes highlighted components Matthew Brooke 04/04/2006 04:59 PM
2345 Bug Resolved Immediate Actor Library classname/icon mapping problems Chad Berkley 05/19/2006 10:56 AM
2341 Bug Resolved Immediate MENUS: Top-Level Menu - Some mapped menu items not working Matthew Brooke 01/26/2006 04:07 PM
2336 Bug Resolved Immediate MENUS: Top-Level Menu - implement class.forName in getActionFor() Matthew Brooke 02/02/2006 12:58 PM
2334 Bug Resolved Immediate MENUS: Top-Level Menu - add support for menu separators Matthew Brooke 01/19/2006 02:26 PM
2333 Bug Resolved Immediate MENUS: Top-Level Menu - relocate code further up class hierarchy Matthew Brooke 03/02/2006 08:35 PM
2332 Bug Resolved Immediate MENUS: Top-Level Menu - link ptii enabled/disabled listeners Matthew Brooke 02/17/2006 06:35 PM
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2321 Bug Resolved Immediate merge exp files into ptolemy CVS Christopher Brooks 05/04/2009 03:37 PM
2314 Bug Resolved Immediate composites show up as classes not instances Chad Berkley 12/14/2005 02:05 PM
2304 Bug Resolved Immediate RExpression accepts only limited input size. Dan Higgins 01/10/2006 03:09 PM
2300 Bug Resolved Immediate migrate to new web services-only ecogrid client in Kepler Kevin Ruland 12/15/2005 06:48 AM
2286 Bug Resolved Immediate SVG - reduce svg file size Matthew Brooke 02/17/2006 06:33 PM
2275 Bug Resolved Immediate Replace the DataCacheManager Kevin Ruland 01/30/2006 10:45 AM
2269 Bug Resolved Immediate SVG - Small Icon (Actor Library Thumbnail) Matthew Brooke 12/08/2005 02:28 PM
2268 Bug Resolved Immediate SVG - Backward Compatibility Matthew Brooke 12/08/2005 02:27 PM
2267 Bug Resolved Immediate SVG - Memory Usage Matthew Brooke 12/15/2005 09:53 PM
2266 Bug Resolved Immediate SVG - Assigning Icons Matthew Brooke 12/15/2005 09:51 PM
2242 Bug Resolved Immediate move metacat ecogrid service to new host Jing Tao 04/17/2006 10:55 AM
2240 Bug Resolved Immediate add support for null values to data passing among ports Christopher Brooks 04/13/2006 12:03 PM
2235 Bug Resolved Immediate Search text-field only 1 character wide on Mac OS X Matthew Brooke 11/03/2005 08:19 PM
2234 Bug Resolved Immediate creating KAR file loses port semantic annotations Chad Berkley 01/24/2006 10:36 AM
2171 Bug Resolved Immediate Add support for missingValueCode in EML parser Jing Tao 04/17/2006 10:54 AM
2145 Bug Resolved Immediate need ontology storage system Shawn Bowers 04/03/2009 01:51 PM
2144 Bug Resolved Immediate fix functionality and GUI issues with query builder Jing Tao 11/01/2005 02:34 PM
2143 Bug Resolved Immediate fix functionality and GUI issues with query builder Jing Tao 06/14/2006 10:52 AM
2142 Bug Resolved Immediate new schema for data sources Jing Tao 04/03/2009 01:52 PM
2141 Bug Resolved Immediate resultset cache expiration problem Kevin Ruland 02/03/2006 12:22 PM
2044 Bug Resolved Immediate R actor for means and error by group Dan Higgins 06/27/2005 01:21 PM
2043 Bug Resolved Immediate create suite of common statistical actors using R Josh Madin 06/14/2006 10:50 AM
2032 Bug Resolved Immediate application should open to main window not web page Christopher Brooks 02/09/2006 09:44 AM
2016 Bug Resolved Immediate MENUS: pop-up context menu revision Matthew Brooke 01/18/2006 02:48 PM
1909 Bug Resolved Immediate generalize cache manager to provide support for very large data files Kevin Ruland 02/03/2006 12:26 PM
1904 Bug Resolved Immediate Nimrod implementation and templates llkay Altintas 10/17/2005 10:13 AM
1901 Bug Resolved Immediate Documentation system llkay Altintas 10/17/2005 10:52 AM
1900 Bug Resolved Immediate Documentation system llkay Altintas 01/21/2005 11:45 AM
1895 Bug Resolved Immediate remote actor repository Chad Berkley 04/26/2006 01:44 PM
1891 Bug Resolved Immediate writedesign for staged implementation of grid-enabled kepler Matt Jones 07/23/2007 10:30 AM
1888 Bug Resolved Immediate changes to data access system to incorporate geon data Efrat Jaeger 03/22/2006 03:41 PM
1883 Bug Resolved Immediate Add LSID to Cache Manager Chad Berkley 12/14/2005 02:07 PM
1881 Bug Resolved Immediate Add intermediate pane to Query Builder Jing Tao 03/01/2006 11:07 AM
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1851 Bug Resolved Immediate save atomic and composite actors in the new actor library Chad Berkley 12/14/2005 02:04 PM
1839 Bug Resolved Immediate adding new port sometimes causes canvas to resize Matthew Brooke 04/12/2007 03:27 PM
1838 Bug Resolved Immediate need user level documentation Kirsten Menger-Anderson 02/04/2008 01:15 PM
1836 Bug Resolved Immediate data search and access problems via ecogrid Jing Tao 01/18/2008 10:35 AM
1829 Bug Resolved Immediate saving workflow invalidates eml data Jing Tao 01/03/2005 04:37 PM
1826 Bug Resolved Immediate keyboard binding to enter key on quick search broken Shawn Bowers 01/06/2005 05:17 PM
1750 Bug Resolved Immediate Allow KAR files to include jar/class files Aaron Aaron 01/27/2010 05:04 PM
1748 Bug Resolved Immediate "Get metadata" menu item only works for EML 2.0.0 documents Matt Jones 03/01/2005 03:01 PM
1747 Bug Resolved Immediate provide display of full metadata for EML200DataSource actors Matt Jones 11/02/2005 01:04 PM
1717 Bug Resolved Immediate EML200 data source throws error on 'Look Inside’ Rod Spears 11/02/2005 01:04 PM
1660 Bug Resolved Immediate Add QueryBuilder to the Data Actors Rod Spears 09/20/2004 06:08 AM
1595 Bug Resolved Immediate Create Advance Query Builder Ul Rod Spears 08/23/2004 11:34 AM
1592 Bug Resolved Immediate describe Sparrow toolkit interface Chad Berkley 10/12/2004 11:08 AM
1589 Bug Resolved Immediate actor testing system Chad Berkley 10/12/2004 11:08 AM
1588 Bug Resolved Immediate create nightly build system Chad Berkley 07/19/2004 01:17 PM
1586 Bug Resolved Immediate Query engine implementation for data query in kepler Jing Tao 01/20/2005 10:24 AM
1584 Bug Resolved Immediate Load data into relational db Jing Tao 01/20/2005 10:21 AM
1579 Bug Resolved Immediate need sub-sampling actor Dan Higgins 01/20/2005 10:01 AM
1557 Bug Resolved Immediate problems with paths with 'spaces’ Dan Higgins 03/01/2005 10:52 AM
1546 Bug Resolved Immediate dynamic data and actor views using ontologies Chad Berkley 10/12/2004 11:06 AM
1544 Bug Resolved Immediate complete web service actor llkay Altintas 11/02/2005 01:04 PM
1343 Bug Resolved Immediate need full eml2 support Chad Berkley 06/14/2004 02:34 PM
1342 Bug Resolved Immediate need R actor Dan Higgins 06/27/2005 01:28 PM
1340 Bug Resolved Immediate define and implement kepler archive file format (kar) Chad Berkley 03/22/2006 03:33 PM
1338 Bug Resolved Immediate find GIS system for inclusion in kepler Dan Higgins 11/02/2005 12:04 PM
1334 Bug Resolved Immediate need installer for kepler Dan Higgins 02/01/2008 10:49 AM
1332 Bug Resolved Immediate GARP improvements and further implemenation Dan Higgins 11/02/2005 01:04 PM
1331 Bug Resolved Immediate interface enhancements Chad Berkley 02/09/2004 08:36 AM
1330 Bug Resolved Immediate interface enhancements Chad Berkley 11/02/2005 01:02 PM
1189 Bug Resolved Immediate add full support for EML2 comple textFormat in EML ingestor Jing Tao 03/23/2005 05:36 PM
6439 Bug Closed Urgent Double rounding fails in some cases while evaluating Expressions Christopher Brooks 03/04/2014 08:34 AM
6629 Bug Closed High type resolution problem when using RecordAssembler Marten Lohstroh 02/03/2015 02:09 AM
5669 Bug Resolved High replace ProjectLocator.findKeplerModulesDir() with something more robust. Daniel Crawl 08/30/2015 04:11 PM
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7191 Bug Resolved Normal memory leak in CompositeActor for actor firing listeners Christopher Brooks 05/18/2017 02:57 PM
7190 Bug Resolved Normal memory leak due to hierarchy listeners when cloning Christopher Brooks 05/22/2017 02:51 PM
6928 Bug Resolved Normal Check Kepler for the Apache commons deserialization problems, consider removing the Daniel Crawl 01/04/2016 02:05 PM
commons-collections-3.2.1 jar file
6834 Bug Resolved Normal kepler data can icon displayed incorrectly Christopher Brooks 09/10/2015 01:19 PM
6831 Bug Closed Normal saving/loading window properties for multiple graphs/models in BasicGraphFrame Christopher Brooks 08/17/2015 01:14 PM
6681 Bug Resolved Normal unnecessary warnings when removing parameters 03/04/2015 10:34 AM
6634 Bug Closed Normal Error message popup not generated when saving to a write protected directory. Christopher Brooks 12/22/2015 02:51 PM
6615 Bug Resolved Normal apple-extensions does not compile with java 8 Daniel Crawl 08/12/2015 03:32 PM
6577 Bug Resolved Normal infinite loop resolving port width Daniel Crawl 09/12/2015 12:12 PM
6572 Bug Resolved Normal An error is thrown when opening MatlabExpression.xml in common/workflows/demos/Matlab Daniel Crawl 12/23/2014 03:28 PM
in trunk.
6467 Bug Closed Normal data tab no longer works Jing Tao 04/11/2014 05:57 PM
6386 Bug Resolved Normal cannot drop second matlab actor on canvas Daniel Crawl 07/15/2014 10:31 AM
6371 Bug Resolved Normal Documentation: missing content in section 1.1.1 Features Daniel Crawl 09/17/2015 12:14 PM
6233 Bug Resolved Normal DirectoryListing NPE Daniel Crawl 11/20/2013 07:10 PM
6000 Bug Closed Normal parameter copy-paste exception on console. Christopher Brooks 11/18/2013 02:19 PM
5901 Bug Resolved Normal Kepler window sometimes only has Reporting view. 04/10/2013 10:26 AM
5895 Bug Resolved Normal HelloWorld link is broken under Kepler-2.4rc3 Daniel Crawl 03/20/2013 03:38 PM
5894 Bug Closed Normal Clone problems in NamedObijld Christopher Brooks 08/17/2015 08:30 AM
5893 Bug Closed Normal During installation, Kepler takes a long time to start up under Windows Christopher Brooks 08/12/2015 04:46 PM
5892 Bug Resolved Normal After running various demos like HelloWorld, the user is prompted to save changes to kar Daniel Crawl 03/19/2013 02:42 PM
5891 Bug Resolved Normal Installer acks need to be update for Ptolemy Derik Barseghian 03/20/2013 10:44 AM
5890 Bug Resolved Normal kepler crash on mac when clinking 'KeplerData' during saving process. Derik Barseghian 03/14/2013 10:09 AM
5838 Bug Works For Me Normal incomplete transfer of error messages into serialized WorkflowRun xml Derik Barseghian 04/08/2013 02:38 PM
5790 Bug Resolved Normal Not all remote run-kars appear in Workflow Run Manager Derik Barseghian 01/29/2013 02:41 PM
5789 Bug Resolved Normal component tree disappears after clicking Clear after downloading KAR Daniel Crawl 01/23/2013 01:50 PM
5782 Bug Resolved Normal wrong behavior when trying to Export a run when module dependencies not satisfied Derik Barseghian 01/15/2013 01:40 PM
5781 Bug Resolved Normal opening a workflow run leaves temp kar entry in Recent Files menu and changes last directory | Derik Barseghian 01/15/2013 01:41 PM
setting
5778 Bug Resolved Normal Force Open doesn't (always?) currently work with Workflow Run Manager Derik Barseghian 01/15/2013 01:39 PM
5759 Bug Resolved Normal MatrixViewer window does not reappear Daniel Crawl 01/15/2013 09:34 AM
5754 Bug Closed Normal unable to open TestSSHWithDisplay 2.3 run-kar from keplerRepository with WRM trunk Derik Barseghian 11/30/2012 02:06 PM
5745 Bug Resolved Normal "./kepler.sh -runwf -nogui -nocache workflow.xml" has error message after execution. jilanwu jianwu 11/26/2012 02:47 PM
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5732 Bug Resolved Normal EML 2.1.1 option should be added to metacat data sources in kepler Jing Tao 11/27/2012 04:45 PM
5727 Bug Resolved Normal saving workflow changes canvas center Daniel Crawl 01/16/2013 07:26 PM
5726 Bug Resolved Normal actor names ending in digit renamed on canvas Daniel Crawl 07/03/2013 04:52 PM
5725 Bug Resolved Normal Save dialog's folder drop-down menu crashes kepler in OS X 10.8 w/ 64-bit java Derik Barseghian 03/14/2013 10:09 AM
1.6.0_37-b06-434-11M3909
5723 Bug Resolved Normal references to parameter are not always renamed Daniel Crawl 06/28/2013 10:44 AM
5722 Bug Resolved Normal Check for problems with sanitized RecordToken labels Daniel Crawl 08/14/2015 04:18 PM
5719 Bug Resolved Normal parameter values no longer appear on canvas Derik Barseghian 10/01/2012 06:13 PM
5716 Bug Resolved Normal Module Manager should only print Downloading messages when actually downloading Daniel Crawl 08/16/2015 07:02 PM
5714 Bug Resolved Normal user manual documentation for 2.4. jianwu jianwu 11/14/2012 05:29 PM
5713 Bug Resolved Normal getting-started-guide documentation for Kepler 2.4 jlanwu jianwu 11/14/2012 03:37 PM
5712 Bug Resolved Normal illegal option chmod error during Kepler startup Derik Barseghian 10/30/2012 03:46 PM
5711 Bug Resolved Normal post release process cheatsheet Derik Barseghian 10/02/2012 12:39 PM
5703 Bug Resolved Normal GUI bug - Deleting an Actor with connected port causes a diamond relation to be created. Christopher Brooks 09/07/2012 10:27 AM
5702 Bug Resolved Normal GUI bug - Initial actor port positioning is wrong Derik Barseghian 09/07/2012 11:08 AM
5701 Bug Resolved Normal CT was removed, demo workflows need to be updated Daniel Crawl 09/14/2012 09:22 PM
5700 Bug Resolved Normal after getting an actors patch, actor changes won't be visible to user until .kepler is removed Daniel Crawl 03/07/2013 02:24 PM
5688 Bug Resolved Normal library not working in kepler trunk in windows7 Derik Barseghian 09/07/2012 11:03 AM
5684 Bug Resolved Normal Add warning to archiving workflow that it must be run on one machine to not produce Derik Barseghian 08/30/2012 06:09 PM
overlapping datasets
5683 Bug Resolved Normal archiveDataturbineDataToMetacat.kar can fail with an IOException on win7 and XP Jing Tao 08/30/2012 05:57 PM
5681 Bug Resolved Normal Tracking bug for sensor-view-0.9.0 release testing Derik Barseghian 08/30/2012 09:37 PM
5680 Bug Resolved Normal after inline save, demo workflow disappears from tree Daniel Crawl 09/17/2012 06:03 PM
5677 Bug Resolved Normal SDF lterations now defaults to AUTO jianwu jianwu 11/14/2012 03:42 PM
5668 Bug Resolved Normal module manager should support batch mode execution. Daniel Crawl 08/30/2015 04:09 PM
5665 Bug Resolved Normal modulemanager et al.: swing-worker-1.2.jar should be removed Daniel Crawl 12/23/2014 03:19 PM
5663 Bug Resolved Normal KeplerGraphFrame has much duplicated code Christopher Brooks 08/07/2012 05:23 PM
5662 Bug Resolved Normal resurgence ArrayAccumulator is a duplicate of Ptolemy ArrayAccumulate Derik Barseghian 09/17/2012 09:44 PM
5661 Bug Resolved Normal Remove SwingWorker and use javax.swing.SwingWorker Jing Tao 08/23/2012 11:49 AM
5660 Bug Resolved Normal ExtensionFileFilter is a duplicate of a Ptolemy class Daniel Crawl 08/17/2012 06:49 PM
5659 Bug Closed Normal Kepler CaseGraphFrame and CaseGraphTableau have duplicated Ptolemy code. Daniel Crawl 08/17/2015 08:10 AM
5658 Bug Resolved Normal Rename kepler/moml/filter classes so that they don't have the same name as the Ptolemy filter | Derik Barseghian 08/06/2012 10:39 PM
classes
5657 Bug Resolved Normal kepler moml FileAttribute should probably be a FileParameter Daniel Crawl 09/14/2012 02:24 PM
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5656 Bug Resolved Normal sdm spa StringConst is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 06:27 PM
5655 Bug Resolved Normal sdm spa Repeat is a duplicate of a Ptolemy actor jianwu jianwu 09/20/2012 10:39 AM
5654 Bug Resolved Normal Geon ArrayRemoveElement is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 08:21 PM
5653 Bug Resolved Normal Geon ArrayContains is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 08:36 PM
5651 Bug Resolved Normal WebService, WebServiceStub and MessageBasedWebService have duplicate code Daniel Crawl 09/18/2012 11:41 AM
5650 Bug Resolved Normal actors LidarWorkflowExecute and load WorkflowExecute have duplicated code Daniel Crawl 09/20/2012 03:44 PM
5649 Bug Resolved Normal opendap/{DapObjectsToToken, TokenManager, TypeManager} are almost identical Daniel Crawl 09/14/2012 02:22 PM
5648 Bug Resolved Normal FileCopier code duplication Sean Riddle 09/17/2012 11:46 AM
5643 Bug Resolved Normal [Fatal Error] :79:7: The element type "nextDiagram" must be terminated by the matching Derik Barseghian 07/25/2012 02:41 PM

end-tag "</nextDiagram>".
5642 Bug Resolved Normal Kepler should have access to the ShowTypes attribute Sean Riddle 10/01/2012 01:28 PM
5638 Bug Resolved Normal "Ok" behavior of Use Module Manager prompt doesn't do what it should when opening from Derik Barseghian 07/13/2012 10:58 AM
Recent Files

5637 Bug Resolved Normal composite window size & position not always saved Daniel Crawl 09/12/2012 09:40 PM
5636 Bug Resolved Normal outreach/demos/Database/Database_example_1.xml workflow fails jianwu jianwu 06/27/2012 04:47 PM
5635 Bug Resolved Normal build-area should have a licenses.txt jianwu jianwu 06/27/2012 04:38 PM
5634 Bug Resolved Normal Kepler should have Configure Layout menu choices Daniel Crawl 06/26/2012 11:56 AM
5629 Bug Resolved Normal Mac DMG installer should have better background and license agreement jilanwu jianwu 09/24/2012 03:56 PM
5625 Bug Resolved Normal create kepler documentation for 2.4 jianwu jianwu 11/26/2012 03:22 PM
5623 Bug Resolved Normal Outline tab context menu problems Daniel Crawl 06/15/2012 04:02 PM
5610 Bug Resolved Normal check that build system can handle a "0.9.0" release Derik Barseghian 06/22/2012 05:20 PM
5609 Bug Resolved Normal use different port for HSQL db in .kepler Daniel Crawl 06/11/2012 11:25 AM
5607 Bug Resolved Normal constant actor icon won't automatically re-size since 2.3. Christopher Brooks 08/06/2012 11:47 AM
5606 Bug Resolved Normal move plotting classes to sensor-view Derik Barseghian 06/18/2012 07:02 PM
5605 Bug Resolved Normal Kepler scheduler doen't work for local workflows in windows os Jing Tao 05/30/2012 08:55 AM
5603 Bug Resolved Normal ant run -Dworkflow=${HOME}/Downloads/SimpleLoop.kar fails Derik Barseghian 06/11/2012 01:58 PM
5602 Bug Resolved Normal Timezone confusion using the scheduler Jing Tao 08/14/2012 06:33 PM
5601 Bug Closed Normal Can still lose report design when saving to KAR Derik Barseghian 04/02/2013 11:06 AM
5598 Bug Resolved Normal parameters appear as white boxes instead of dots Daniel Crawl 11/30/2012 04:10 PM
5595 Bug Resolved Normal GetMetadata Menu doesn't work in eml actor when it handles local eml document and data file | Derik Barseghian 05/09/2012 10:55 AM
5592 Bug Resolved Normal Site Layout DE Director missing documentation Derik Barseghian 06/13/2012 07:08 PM
5589 Bug Resolved Normal Add missing ptolemy actors to library Daniel Crawl 07/27/2012 05:37 PM
5588 Bug Resolved Normal Enter and Tab behavior has changed in parameter configuration dialog Daniel Crawl 08/24/2012 01:02 PM
5587 Bug Resolved Normal long parameter values get replaced with scrollbar Christopher Brooks 08/29/2012 09:44 PM
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5580 Bug Resolved Normal create sensor-view module documentation Derik Barseghian 08/03/2012 02:05 PM
5579 Bug Resolved Normal Upload to Repository on actors doesn't work Derik Barseghian 06/15/2012 11:41 AM
5578 Bug Resolved Normal Add DiffModules with build-area Derik Barseghian 06/14/2012 11:51 AM
5576 Bug Resolved Normal memory leak in ptolemy.data.expr.CachedMethod Daniel Crawl 06/25/2012 11:20 AM
5575 Bug Resolved Normal open composites from outline tab Derik Barseghian 03/14/2012 11:51 AM
5574 Bug Resolved Normal exception from gui in java 7 Derik Barseghian 02/15/2012 08:57 PM
5573 Bug Resolved Normal remove ptolemy vendors/ Christopher Brooks 03/07/2013 02:25 PM
5571 Bug Resolved Normal user request: show execution time in runtime window Christopher Brooks 06/15/2012 02:23 PM
5565 Bug Resolved Normal deal with licensing for oracle jar in core Daniel Crawl 06/15/2012 02:30 PM
5564 Bug Resolved Normal dragging sdf director to the canvas causes exception Derik Barseghian 12/06/2011 07:29 PM
5552 Bug Resolved Normal Workflow Scheduler GUI needs a licenses.txt file Jing Tao 12/21/2011 02:26 PM
5550 Bug Resolved Normal Windows installer should be a .exe, not a .jar Christopher Brooks 06/26/2012 10:57 AM
5549 Bug Resolved Normal Help=>Modules Documentation not working in ubuntu Derik Barseghian 11/21/2011 05:15 PM
5546 Bug Resolved Normal SDF director iterations parameter default of 0 is unfriendly Christopher Brooks 08/15/2012 07:15 AM
5545 Bug Resolved Normal Configure Ports dialog Type column gui annoyances Derik Barseghian 06/15/2012 03:54 PM
5540 Bug Resolved Normal Automate Layout no longer uses Kieler on trunk Derik Barseghian 05/01/2012 08:49 PM
5539 Bug Resolved Normal Open Actor does not find the actor source code when Kepler is invoked from within Eclipse Derik Barseghian 06/24/2012 10:23 AM
5529 Bug Resolved Normal Documentation for some actors such as Run Composite Actor is empty Daniel Crawl 08/22/2012 05:34 PM
5512 Bug Resolved Normal Provenance module does not work with MySQL (RecordingException: com.mysql.jbc Daniel Crawl 10/25/2011 10:20 AM

MysglDataTruncation)

5509 Bug Resolved Normal How do | run the demos Daniel Crawl 07/31/2012 12:45 PM
5508 Bug Resolved Normal Link to "Additional background information on Ptolemy" brings up empty page Christopher Brooks 11/22/2011 11:17 AM
5507 Bug Resolved Normal Windows Installer: The R choice is not unselectable Derik Barseghian 11/08/2011 06:46 PM
5506 Bug Resolved Normal Windows Installer Page does not mention 2.3? Derik Barseghian 11/21/2011 07:29 PM
5505 Bug Resolved Normal Kepler-2.3 installer should create directory named "Kepler-2.3", not "Kepler" Derik Barseghian 11/08/2011 06:38 PM
5504 Bug Resolved Normal Kepler incorrectly uses old version of a kar file in ~KeplerData/workflows/MyWorkflows David Welker 11/10/2011 05:37 PM
5502 Bug Resolved Normal use https to svn check out modules Derik Barseghian 12/05/2011 06:23 PM
5501 Bug Resolved Normal Got an java.lang.NullPointerException when click any menu after downloading a kar file David Welker 11/21/2011 03:13 PM
5500 Bug Resolved Normal unable to open kar in relaxed mode saved in patched 2.2.0 in 2.3.0 Derik Barseghian 09/30/2011 10:03 PM
5498 Bug Resolved Normal Issue a patch for ptolemy classpath problem in kepler-2.2 Derik Barseghian 06/15/2012 11:47 AM
5496 Bug Resolved Normal non-English (United State) OS locale causes File menu and button text to not show Daniel Crawl 09/27/2011 04:42 PM
5495 Bug Resolved Normal released kepler should allow getting patches and changing suites from command line jianwu jianwu 08/08/2012 03:47 PM
5494 Bug Resolved Normal existence of remote 2.2 patches can cause 2.3 to fail to start 2.2 on first attempt Derik Barseghian 09/22/2011 06:45 PM
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5490 Bug Resolved Normal update splash screen version without changing image Matt Jones 08/17/2015 09:20 AM
5489 Bug Resolved Normal Module Manager GUI should fail gracefully if a remote module cannot be downloaded Derik Barseghian 09/19/2012 04:18 PM
5488 Bug Resolved Normal domain/username/password in command line hadn't been parsed in kepler when kepler Jing Tao 09/08/2011 04:58 PM

needed them to access external data objects
5487 Bug Resolved Normal blank modules.txt files created for non-suite modules jianwu jianwu 03/11/2013 11:51 AM
5486 Bug Resolved Normal Need a mechanism to tell the user the information about setup the scheduler and workflow run | Jing Tao 12/01/2011 09:20 AM
engine

5485 Bug Resolved Normal standalone Module Manager can break Kepler app ability to startup Derik Barseghian 11/06/2012 05:45 PM
5484 Bug Resolved Normal Module Manager GUI can fail to close and quit parent process David Welker 09/30/2011 10:55 PM
5473 Bug Resolved Normal 2.3.0rc1 won't start on Windows XP David Welker 09/30/2011 10:58 PM
5463 Bug Resolved Normal Provide security for Kepler databases Daniel Crawl 08/15/2011 02:18 PM
5462 Bug Resolved Normal Can't run the kepler by ./kepler.sh after decompressing the linux installer David Welker 08/15/2011 09:20 AM
5461 Bug Resolved Normal Add a directory to contain all modules in linux installer David Welker 08/22/2011 04:28 PM
5460 Bug Resolved Normal Mac OS X: Matlab Actors fail in Kepler.app David Welker 10/05/2011 05:38 PM
5459 Bug Resolved Normal Kepler 2.3 blocking bug David Welker 08/14/2011 04:13 PM
5458 Bug Resolved Normal Moving between 2.2 and 2.3 and back requires deleting ~/KeplerData jilanwu jianwu 03/11/2013 01:43 PM
5457 Bug Resolved Normal Mac OS X: Kepler.app should display module error messages in a window Christopher Brooks 08/29/2012 08:21 PM
5456 Bug Resolved Normal Documentation for Reporting 2.3.0 Derik Barseghian 11/23/2011 02:53 PM
5455 Bug Resolved Normal Documentation for 2.3.0 Derik Barseghian 08/12/2011 06:21 PM
5454 Bug Resolved Normal DEBUG->ANIMATE EXECUTION error message David Welker 08/06/2011 10:50 AM
5453 Bug Resolved Normal ant javadoc -Dfull=true fails llkay Altintas 06/13/2012 07:04 PM
5452 Bug Resolved Normal uneasy access to the demo workflows Daniel Crawl 07/31/2012 12:43 PM
5451 Bug Resolved Normal Componets ->(right mouse) View Dokumentation causes NameDuplicationException llkay Altintas 08/06/2011 10:51 AM
5450 Bug Resolved Normal Menu: Help -> Kepler Documentation causes lllegalArgumentException David Welker 11/03/2011 07:21 PM
5449 Bug Resolved Normal Running ant should include instructions about updating kepler-tasks.jar David Welker 06/17/2012 04:51 PM
5448 Bug Resolved Normal cannot start Kepler using non-lcedTea OpenJDK Christopher Brooks 06/15/2012 11:48 AM
5447 Bug Resolved Normal Use https, not svn to check out the ptll repository David Welker 08/04/2011 02:01 PM
5446 Bug Resolved Normal View=>XML View broken David Welker 08/02/2011 04:25 PM
5445 Bug Resolved Normal Kepler 2.2.0 tar file should create a kepler-2.2.0 directory David Welker 08/15/2011 09:01 AM
5442 Bug Resolved Normal View->Automate Layout doesn't work in kepler-2.3 branch David Welker 09/26/2011 05:34 PM
5441 Bug Resolved Normal no 'work will be lost' warning when accepting a patch via Module Manager David Welker 07/13/2011 02:22 PM
5440 Bug Resolved Normal special checkout behavior for hardcoded ptolemy module names jilanwu jianwu 08/06/2012 12:07 PM
5439 Bug Resolved Normal file parameter ignores directory David Welker 07/11/2011 07:23 PM
5438 Bug Resolved Normal missed menubar and misformed buttons without text David Welker 08/04/2011 09:57 AM
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5437 Bug Resolved Normal provenance hsqldb database doesn't behave as though it's properly shutdown when in server | Daniel Crawl 06/11/2012 04:06 PM
mode
5436 Bug Resolved Normal KeplerConfigurationApplication does not show run exception David Welker 07/20/2011 01:56 PM
5434 Bug Resolved Normal run-kar result from headless kepler.sh execution doesn't contain report artifacts Derik Barseghian 06/30/2011 03:19 PM
5433 Bug Resolved Normal use 1024m instead of 512m for reporting suite Derik Barseghian 07/08/2011 03:37 PM
5432 Bug Resolved Normal 2.2 mac installer contains 2 copies of everything David Welker 08/12/2011 08:05 PM
5430 Bug Resolved Normal problems with multiple instances of kepler Derik Barseghian 08/05/2011 07:59 AM
5426 Bug Resolved Normal workflow Isid changes when running from command line Daniel Crawl 08/17/2012 06:49 PM
5424 Bug Resolved Normal see if it's worthwhile to upgrade hsql from 1.8 Daniel Crawl 02/05/2015 10:16 AM
5422 Bug Resolved Normal Tools=>Tag Manager... menu option is missing Sean Riddle 06/14/2011 06:48 PM
5420 Bug Resolved Normal Two types of NPE issues when 2.2.0 installed and run by a non-admin windows user David Welker 06/13/2011 12:57 PM
5419 Bug Resolved Normal Cannot open KARs saved in 2.1.0 suites in 2.2.0 in relaxed mode because ptolemy module David Welker 07/13/2011 02:24 PM
changed names
5418 Bug Resolved Normal Build System resets modules.ixt during update Derik Barseghian 08/06/2012 12:40 PM
5417 Bug Resolved Normal changes to a sensor's serial-number param do not get written to config file Derik Barseghian 05/31/2011 01:48 PM
5416 Bug Resolved Normal downloaded modules by Kepler module manager should know the path of main Kepler jilanwu jianwu 08/08/2012 05:31 PM
installation.
5415 Bug Resolved Normal module releasing and downloading by module manager should keep file mode. jilanwu jianwu 07/27/2012 01:30 PM
5414 Bug Resolved Normal fileparameter browse has NPE Christopher Brooks 05/31/2011 02:47 PM
5412 Bug Resolved Normal saving with an open plot window crashes David Welker 06/10/2011 12:42 PM
5411 Bug Resolved Normal file->save to xml does not work David Welker 06/10/2011 12:40 PM
5410 Bug Resolved Normal provenance data is not flushed to HSQL database before Kepler quit. Daniel Crawl 06/16/2011 11:00 AM
5409 Bug Resolved Normal reporting 2.1 can not start when setting "JDBC URL" in provenance. Daniel Crawl 06/06/2011 06:18 PM
5408 Bug Resolved Normal dataturbine actor should reuse connection Derik Barseghian 03/29/2012 06:49 PM
5407 Bug Resolved Normal wrm/tagging have errors when starting with provenance turned off Derik Barseghian 06/22/2011 01:42 PM
5406 Bug Resolved Normal "./kepler.sh -runwf -nogui" won't work if the workflow file path includes 'repository’ David Welker 06/12/2012 11:31 AM
5404 Bug Resolved Normal change-sampling.kar demo no longer works Derik Barseghian 03/27/2012 07:49 PM
5403 Bug Resolved Normal Improve the performance of the workflow archiving data from dataturbine to metacat Derik Barseghian 08/24/2012 07:35 PM
5402 Bug Resolved Normal Linux build at r27617 can't drag instantiate components David Welker 05/13/2011 03:58 PM
5399 Bug Resolved Normal "./kepler.sh -runwf -nogui -nocache" command will not quit if some parameters are set. David Welker 06/14/2012 11:51 AM
5398 Bug Resolved Normal Re-install of Kepler-x.y doesn't overwrite modules.txt jianwu jianwu 08/24/2012 10:19 AM
5397 Bug Resolved Normal "/kepler.sh -runwf -nogui workflow.xml" doestn't work if the user is logged out on Mac David Welker 11/26/2012 02:57 PM
5396 Bug Resolved Normal rename ptolemy-8.1.0 module for the kepler 2.2 release David Welker 05/25/2011 04:44 PM
5390 Bug Resolved Normal EML created by DataTurbineToMetacat workflow should have the spatial coverage Derik Barseghian 05/04/2011 04:40 PM
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5381 Bug Resolved Normal run-workflow does not work for KAR files David Welker 06/11/2012 11:50 AM
5380 Bug Resolved Normal Save As no longer disposes old window Aaron Aaron 04/26/2011 05:00 PM
5379 Bug Resolved Normal SPAN - add writing metadata changes to pending files Daniel Crawl 04/18/2011 02:03 PM
5378 Bug Resolved Normal add rety logic to SpanTodt, attempt to recover if RBNB goes down Derik Barseghian 06/14/2012 08:45 PM
5375 Bug Resolved Normal data not sent out after accumulating a large number of files in pending/ Derik Barseghian 04/05/2011 04:42 PM
5361 Bug Resolved Normal Animate at Runtime broken Aaron Aaron 04/26/2011 03:45 PM
5360 Bug Resolved Normal changes to a sensor parameter might not take effect until next current sample Derik Barseghian 04/18/2011 03:39 PM
5359 Bug Resolved Normal SpanToDT NoClassDefFoundError Derik Barseghian 03/30/2011 10:36 AM
5358 Bug Resolved Normal CompositeActor name can disappear jianwu jianwu 03/24/2011 05:32 PM
5356 Bug Resolved Normal ArchivingDataturbine workflow couldn't update the second sensor's lastArchiving time in Jing Tao 04/04/2011 04:12 PM
command line mode
5355 Bug Resolved Normal actor documentation not included on instantiation Daniel Crawl 06/13/2012 07:06 PM
5352 Bug Resolved Normal build-area-2.1 is not working and build-area-2.2 is needed for kepler-2.2 release. David Welker 05/24/2011 04:57 PM
5351 Bug Resolved Normal Couldn't open a composite actor at the second time David Welker 04/18/2011 04:02 PM
5349 Bug Resolved Normal Cannot open KAR file after modifying it. jianwu jianwu 06/18/2012 02:55 PM
5348 Bug Resolved Normal Opening KAR or opening workflow under KAR behaves differently. jianwu jianwu 08/07/2012 04:05 PM
5346 Bug Resolved Normal Kepler 2.2r3 Mac OS 64-bit Matlab demo fails with 'no suitable image found' David Welker 05/18/2011 04:55 PM
5345 Bug Resolved Normal Kepler 2.2rc3 Copyright should be updated to 2011 David Welker 06/01/2011 07:18 PM
5342 Bug Resolved Normal ant update hangs if the svn certificate changes (and possibly always hangs the first time) David Welker 08/04/2011 11:37 AM
5337 Bug Resolved Normal NPE from WorkflowManager when configuring actor within composite Derik Barseghian 03/04/2011 01:29 PM
5335 Bug Resolved Normal SpanToDT should write metadata first rather than data when it starts up Daniel Crawl 03/04/2011 10:18 AM
5334 Bug Resolved Normal 2.2 rc3: kepler.sh file is not executable by default in Kepler.app/Contents/Resources/Java/ David Welker 03/01/2011 05:21 PM
directory
5332 Bug Resolved Normal cr1k_d doesn't reliably connect to logger Derik Barseghian 04/12/2011 11:48 AM
5331 Bug Resolved Normal Errors in Help->Kepler Documentation page at kepler 2.2 rc3. David Welker 03/01/2011 04:28 PM
5328 Bug Resolved Normal 2.2rc2 - standalone module manager won't start David Welker 02/28/2011 09:25 PM
5326 Bug Resolved Normal 2.2rc2 - upgrade config file bug workaround moves KeplerData/modules to David Welker 05/24/2011 04:36 PM
KeplerData/modules.old instead of just configuration file dirs
5325 Bug Resolved Normal 2.2rc2 - documentation problems David Welker 02/28/2011 09:25 PM
5324 Bug Resolved Normal dcd_mgr buffer too small -- xxx Lost data.. messages Derik Barseghian 04/04/2011 09:48 AM
5323 Bug Resolved Normal saving Site Layout workflow makes Sensor actor parameters editable Daniel Crawl 03/03/2011 03:10 PM
5322 Bug Resolved Normal dcd_mgr crashes often Derik Barseghian 03/08/2011 02:43 PM
5321 Bug Resolved Normal sensor settings made by kepler user lost on SPAN restart Daniel Crawl 04/18/2011 03:40 PM
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5320 Bug Resolved Normal Get "could not find entity 1876 in parameter table" when run the dataturbineToMetacat Daniel Crawl 07/07/2011 02:21 PM
workflow
5319 Bug Resolved Normal The workflow which archive sensor data into metacat can upload incorrect data set when new | Jing Tao 03/22/2011 04:30 PM
data is coming
5318 Bug Resolved Normal 2.2.0 release testing David Welker 05/24/2011 05:05 PM
5315 Bug Resolved Normal Sensor Site view Components only filtered when All Ontologies and Folders selected Derik Barseghian 03/29/2011 03:22 PM
5312 Bug Resolved Normal updating windowsXP installed 2.0.0 straight to 2.2.0 renders Kepler unable to start David Welker 02/22/2011 01:23 PM
5311 Bug Resolved Normal 2.2.0rc1 - remote data sources don't work Jing Tao 02/17/2011 03:11 PM
5310 Bug Resolved Normal 2.2.0rc1 - Documentation link problems David Welker 02/24/2011 02:11 PM
5309 Bug Resolved Normal 2.2.0rc1 - Preferences and Components Search (configuration) issue David Welker 02/15/2011 10:32 PM
5303 Bug Resolved Normal The workflow which archive sensor data into metacat can upload data even no new data was |Jing Tao 03/22/2011 04:33 PM
generated
5302 Bug Resolved Normal module_dependencies column defined too short Daniel Crawl 06/21/2011 01:34 PM
5301 Bug Resolved Normal clicking on Image item Scale Property Value sometimes gives Derik Barseghian 02/14/2011 12:49 PM
ArrayIndexOutOfBoundException
5297 Bug Resolved Normal Workflow Run Manager - no indication of progress during preview runs download Derik Barseghian 02/08/2011 04:20 PM
5296 Bug Resolved Normal Workflow Run Manager - multiple window, remote store gui refresh issue Derik Barseghian 02/14/2011 05:56 PM
5295 Bug Resolved Normal Report designer panel gui simplification and spacing Derik Barseghian 02/08/2011 04:45 PM
5293 Bug Resolved Normal Deleting a report item scrolls you to top of design Derik Barseghian 02/11/2011 12:36 PM
5287 Bug Resolved Normal Remove the override of ActorMetadataKAREntryHandler Daniel Crawl 03/29/2011 02:35 PM
5286 Bug Resolved Normal Remove the override of EntityTreeModel Derik Barseghian 06/15/2012 02:19 PM
5283 Bug Resolved Normal Ul for saving workflows as xml is confusing Daniel Crawl 06/28/2012 04:25 PM
5282 Bug Resolved Normal Documentation updates for 2.2 David Welker 01/31/2011 01:07 PM
5280 Bug Resolved Normal missing command line execution for KAR files Daniel Crawl 08/18/2012 04:55 PM
5279 Bug Resolved Normal HSQL databases use default account Daniel Crawl 09/21/2012 02:38 PM
5278 Bug Resolved Normal HSQL database is shared between users Daniel Crawl 04/16/2013 10:32 AM
5277 Bug Resolved Normal remove test servers from Sources preferences Derik Barseghian 01/28/2011 02:00 PM
5275 Bug Resolved Normal Executing sensor-view workflow records provenance Daniel Crawl 02/14/2011 01:45 PM
5274 Bug Resolved Normal Trying to schedule workflow with report layout puts up prompt about no report layout Jing Tao 02/14/2011 01:45 PM
5272 Bug Resolved Normal kepler 2.1 suite can not be started using 'ant run’ David Welker 01/31/2011 02:29 PM
5270 Bug Resolved Normal No menu bar and labels when non-default locale is set David Welker 08/04/2011 09:55 AM
5266 Bug Resolved Normal Two empty boxes inside Sinewave actor and other icon problems for attributes Christopher Brooks 12/07/2012 10:39 AM
5265 Bug Resolved Normal Kepler 2.1.0 has omitted the Publish & subscribe actors from Ptolemy David Welker 01/05/2011 08:16 AM
5261 Bug Resolved Normal Get an error when execute the dataturbineToMetacat workflow in the second time Jing Tao 02/25/2011 11:11 AM
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5260 Bug Resolved Normal Problems with unknown free-form tags Sean Riddle 01/12/2011 02:28 PM
5259 Bug Resolved Normal kepler/util/src/util/LineReader.java should be updated to match Ptolemy sources Derik Barseghian 09/18/2012 02:01 PM
5254 Bug Resolved Normal provenance database connections keep growing when using Reporting suite. Derik Barseghian 12/10/2010 06:48 PM
5253 Bug Resolved Normal SpanToDT timestamp bug Daniel Crawl 04/12/2011 03:02 PM
5251 Bug Resolved Normal using File->Open MoML... always opens model into Sensor Site view Sean Riddle 02/14/2011 01:45 PM
5250 Bug Resolved Normal confusing ant options. David Welker 12/01/2010 11:33 AM
5248 Bug Resolved Normal downloading non-public kars from Search Components doesn't work Derik Barseghian 01/31/2011 06:20 PM
5247 Bug Resolved Normal Allow user to set memory allocated to Kepler from within Kepler Derik Barseghian 08/06/2012 03:29 PM
5240 Bug Resolved Normal NameDuplicationException from SequencePlotter Christopher Brooks 06/15/2012 03:29 PM
5237 Bug Resolved Normal Downloading kars on os X 10.6 locks Kepler Chad Berkley 11/10/2010 02:14 PM
5236 Bug Resolved Normal The list on the left panel of the scheduler should only show WF objects that can be scheduled. |Jing Tao 02/14/2011 01:45 PM
5235 Bug Resolved Normal Scheduler GUI can schedule any wf (even local ones). Jing Tao 02/23/2011 04:55 PM
5233 Bug Resolved Normal Remote component search messes up returns which have the same karFileName in kar xml Jing Tao 11/03/2010 05:58 PM
5232 Bug Resolved Normal unable to open KARs saved beneath absent (e.g. third party) modules David Welker 01/28/2011 06:28 PM
5231 Bug Resolved Normal Tools => Preferences menu item gives error on trunk Derik Barseghian 10/28/2010 01:15 PM
5230 Bug Resolved Normal saving workflow that has instances of user created class to a KAR gives errors Chad Berkley 10/29/2010 10:23 AM
5229 Bug Resolved Normal Poor component search performance Chad Berkley 02/04/2011 01:17 PM
5228 Bug Resolved Normal Load splash screen and icons from the classpath, not specific modules. David Welker 12/01/2010 02:46 PM
5227 Bug Resolved Normal Finish work on installers. David Welker 11/29/2010 02:54 PM
5226 Bug Resolved Normal User should be warned to design a report if there isn't a report when scheduling Jing Tao 02/14/2011 01:45 PM
5225 Bug Resolved Normal problems loading & saving KARs when disconnected Chad Berkley 11/01/2010 10:44 AM
5223 Bug Resolved Normal Store the last timestamp of data store for a sensor to the local database manish manish 02/17/2011 11:59 AM
5222 Bug Resolved Normal Store data set file and associated EML file into metacat manish manish 02/17/2011 11:59 AM
5221 Bug Resolved Normal Create EML string manish manish 02/17/2011 11:59 AM
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